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ABOUT THE MILL TUTORIALS
The easiest andmost effective way to learn the system is to actually program a part, which is what
we will do in this tutorial. The following step-by-step instructions guide you through setting up a part,
creating tools, machining operations, and post processing. The geometry for the part was created
in the Geometry Creation tutorial. For dimensions of the part, see “Part Print” on page 73.
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BASIC MILL TUTORIAL

This tutorial uses a part we created in the Geometry Creation tutorial. Wewill go over the part
setup, creating tools, processes and operations.Wewill then render the part to ensure we have
what we want. Finally we will post the part.

Setting Up The Part

Open An Existing File

1. Click the Document Control Dialog button in the Command palette.

2. Click theOpen button.

3. Locate and choose theMill Tutorial.vnc part that was created in the Geometry Creation tutorial.

If you have not created the geometry for the part, go back to the Geometry Creation tutorial and
do so, or open it from the Sample parts folder.

Youmight need to change the current drive and directory in order to locate the file.

4. ClickOpen.

Parts can also be opened by:

• Double-clicking the associated VNC part file with the system icon.

• Drag and drop the part file icon onto the application icon, shortcut or application
Workspace.

About the Part

TheDocument Control dialog now contains the information for theMill Tutorial part. The top dialog
containsMaterial selections in a pop-upmenu. TheMaterialmenuwill havemultiple selections
available if you have purchased the CutDATA™material library or created your ownMaterial
Database. Otherwise, there is only the default selection for materials. For more detailed information
on theMaterial Database, refer to the CommonReference user guide, "Materials" chapter.

1. Set thematerial type to AluminumAlloy, Cast.
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If you have not purchased CutDATA you will not be able to perform this task. That is fine, just be
aware that the feeds and speeds used in this tutorial will come from thematerial database and are
for cutting aluminumwhich is the onlymaterial available to users who do not have CutDATA.

2. Verify the settings are as
shown.

The stock size values affect how the geometry of the part is shown on the screen andMaterial Only
calculation. It is recommended that the stock size values closely resemble the initial part stock
dimensions.

The Clearance Plane Z indicateswhere the tool will rapid to immediately after a tool change. It also
specifies the last rapidmove the tool will make before going to the Tool Change Position. Additionally,
the tool will move to this position between drillingmoves if the second Retract to Z option is selected
in the Drilling Process dialog. For more information on ClearanceMoves and Drill process dialog
refer to theMill user guide, "Machining" chapter.
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The Tool Change Position is used onmillingmachineswithout automatic tool changers. It is also used
when the tablemust bemoved to avoid crashing during a tool change due to a tall part, fixtures, or a
rotary table.

3. Close this dialog.

Familiarizing Yourself With The Part

The geometry previously created in the Geometry Creationmanual is drawn in the workspace
outline.

We are currently looking at the top view of the part, or the XY plane. In order to get a better
visual of the part, we will change the view.

1. Open the View Control palette.

The View Control palette, also referred to as the Trackball, allows you to change views,
Redraw, and Unzoom. You can select the different options by clicking on the corresponding
buttons.

For an explanation of the various buttons and views, we will turn on the Balloons option.

2. Turn on Balloon help (Help >Dynamic Help> Balloons) or use the shortcut (Ctrl+B).
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The Balloons option provides on-line reference information.
Notice that the Balloons icon now displayswithin a blue box
indicating that amenu item is in use.

To see the balloon help popups, move the cursor over the
desired object.

3. Click the Isometric view button.

Isometric view allows you to see the wireframe of the stock. The Top view is recommended for
creating geometry and toolpath for a 3-Axis part, while the Isometric view is excellent for
rendering.

4. Choose Help > Balloons (Ctrl+B).

This will turn the Balloons off.

Turn on Balloons whenever you want online reference information on the various
functions of the system.

5. Click the Top View button (Ctrl+E) .

6. Click the View Control button to close the View palette.

TheMainMenu View submenu also allows you to select all of the views available in the View
palette. It also has additional commands that may be useful for viewing your part.
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Now look at the bottom left of the screen. You will see an axismarker. Hover over thismarker
and you will see a Trackball appear. This is very useful to enable quick view changes to bemade.

You can change the position of thismarker to any corner of the screen by editing the File >
Preferences > Display > Edit Appearance Settings > Background tab and setting the Draw Axis location
(or turning it off).

Now try right-clicking on the center of the
trackball or view palette. A dropdownmenu
appears with a Customize option. This option
enables you to add common commands to your
trackball, simply by dragging them onto the
required buttons. Extra commands can be added
in combination with the Shift, Ctrl and Alt keys.
Use the Reset option to delete the customization.

Look at the bottom right border of the screen. This area gives basic information about the part (Inch
or metric). Current Coordinate System andWorkgroup are shown (click them to open the dialogs).

The Trashcan and Progress bar are also situated here, where they are easily accessible. If your
part is to be duplicated, this will also be indicated.

7. Double-click the CS button. The CS dialog opens. Use

the to close the dialog.

Creating a Tool list

1. Click the Tool list button in theMain palette.

When you click this button, the Tool tile list will appear in the upper left-hand side of the screen.
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2. Double-click the empty tile position #1 in the Tool list.

A Tool Creation dialog will appear on the screen when you double-click an empty Tool tile
location. All tool specificationswill be entered in a Tool dialog similar to the one shown.
Information in this dialog can be edited at any time during part creation. If operations have
already been created using the edited tool, you will need to reprocess the operations in order for
the new tool specifications to take effect.

3. Select rEM (Rough Endmill)
and enter the values shown.

This is a 3/4" High Speed Steel flat-bottomed endmill and will be used for roughing the part. The
particular holder you select is not important and unless you runOp Sim you will not see it.
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4. Double-click tile position #2 in the Tool tile list.

This closes the Tool #1 dialog and brings up the Tool # 2 dialog. A Tool tile
displaying Tool 1 type and tool diameter appears in the first position of the Tool
tile list.

5. Select fEM (Finish Endmill)
and enter the tool
information shown.

This is a High Speed Steel flat-bottomed finish endmill with a 0.05" bottom corner radius and will
be used for finish contour passes on the part.

6. Double-click tile position #3 in the Tool list.
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7. Create a Spot Drill as shown. By
typing 5/16 in the diameter field
and then pressing the ENTER key,
GibbsCAM will calculate a
diameter of 0.3125 for you.

This is a fairly standard 5/16" spot
drill.

8. Double-click tile position #4 in the Tool list.

9. Create a Drill as shown.

This standard drill will be used for drilling out tap holes.
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10. Create a Tap tool as shown.

This is a standard 20 TPI
tap.

11. Create a Drill as shown.

 This 3/4" drill will be used to
make entry holes for the
roughing operations.

12. Close the tool dialog (Ctrl+W).

Our tool list is complete. Wewill now make aminor modification to the list and look at a tool that
tells us about our chosen tools.
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More About the Tools

Tool #6 is actually going to be the first tool we will use as it is going tomake some entry holes for us.
While the position of a tool in the list is not important, it is convenient to keep them in some sort of
logical order, such as order of use.

1. Drag tool #6 up to the insertion point above tile
position #1. As you drag the tile, the cursor changes
to a hand symbol. Put the tip of the fingers on the line
above where you want the tile to go.

A blue arrow appears indicating where the tool will be
inserted.When you let go themouse, the tile is put into
position. As you can see, reordering tools is very easy.

The tools necessary tomachine this part have been created.Wewill now review the tool
specificationswith the Tool Manager dialog.

2. ChooseWindow >Managers> Tool Manager or right-click a tool tile.

This dialog contains a list of all of the current tools and the tool specifications. The columns
displayed can be customized by right-clicking the heading row. Print or save this information by
selecting the appropriate icons.
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Saving a tool list

Wewill now add these tools to a tool list file so that we can use them in other parts.

1. Right-click on any Tool Tile to display the Tool list menu as shown.

2. Select the option View/Edit Tool List and navigate to the sample file tools.tlst.
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3. ClickOpen. The tool list opens.

4. Click in a tool tile and Ctrl-A to select all the tools in your list.

5. Now drag the highlighted tools and drop them into the Tool list dialog.

6. The tools will automatically be sorted into the correct types.

7. Close the Tool list dialog and save your changes.

Creating Operations
About Processes and the Process List

Wewill now begin tomake toolpath. A toolpath is contained within or defined by operations, such as
a drilling operation or a roughing operation. The actual parameters of the operation are set by a
processes.Wewill learn about making processes and operations in this section.

1. Open the CAM lists.

The Process list appears under the Tool list on the left of the screen and theOperations list
appears on the right of the screen.

Processes

Process tiles are created in one of two ways:

The first is by choosing the required tool from the Tool tiles and dragging it to a Process list tile. The
Process dialog then appears and you select the process type you require.
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The other, more intuitive way is to double-click a process tile, select the process required and then
choose a tool suitable for that process.When you create a process this way, the systemwill list the
most suitable tools for the process first. If the correct tool is not found you can immediately create
one. You are of course free to choose any suitable tool that in your tool list.

Operations

Operationsmust be created in order to machine any part. Operation tiles are automatically created

fromProcess tiles when a cut shape is selected and the Do It or Redo button is
clicked.

The First Processes - Drill, Rough and Contour

First, we will create a group of operations to rough and finish the inside of the contour. This will be
accomplished usingMultiple Process Programming which allows for multiple processes to be
applied to one cut shape to createmultiple operations.

1. Double-click process tile #1. The Process selection dialog opens. Select a Drill
process.

The drill process icon now appears in the process list and you are presented with the tool choice
dialog. You will notice that the spot drill appears at the top, as this would normally be used first to
drill a pilot hole. Wewill choose the 3/4” standard Drill on this occasion. Hovering over the tool icon
as shown below will reveal a snapshot of the tool specification. This will enable you to confirm it is
indeed Tool #1.

When you have selected the tool, the Tool number, which is #1 in this case, will be displayed in
the small box on the Drilling process tile.

In addition, the Drilling process specification dialog will appear.
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2. Enter the following into the Drill
process shown.

This process sets the clearances to
0.1" above thematerial which is at
Z0. The tip of the drill will cut 0.45"
deep and the tool will feed in and
rapid out of the hole.
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3. Click the Pre-Mill tab and set the
parameters as shown.

These settings generate entry holes
for the following tool.

4. Close the Process dialog (Ctrl+W).

5. Double-click Process tile #2 in the Process list and click the Roughing process.

6. Select the Rough Pocketing tool suggested (Tool #2).
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7. Create the Roughing Process
shown.

This is a standard Offset roughing process. The tool will cut to Z-0.5" in two steps of 0.25". We
have an entrymove of .05 perpendicular to the wall. Typically this is where your cutter compwill
be applied. Then we have a radiusmove of .25 aswe cut into the wall. This is a roughing
operation so we aren’t concerned with leaving a clean wall. In fact, we are leaving 0.025" of
stock on the walls for the next operation to clean up. Different stock amounts can be specified
for pocket and island walls. The value entered indicates how muchmaterial will be left on the
walls (per side) after the toolpath is completed. In this case we are leaving the same amount of
material.

The tool entry style selections determine how the tool will enter thematerial. When Auto Plunge
is selected, the systemwill calculate the optimal location for the tool to plunge into thematerial to
begin cutting.

TheOpen Sides tab title is bold, whichmeans it could have some bearing on the toolpath, but
this operation will not have any open sides. You can ignore the Open Sides tab in this case.

8. Close the Roughing Process dialog (Ctrl+W) .
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9. Double-click position #3 in the Process list and choose Contour.

10. Choose the .5” Finish Endmill (Tool #3).

11. Create the Contour Process as
shown.

This operation will also cut to a final depth of Z-0.5" but will do so in a single step. As this
operation is finishing walls we have specified that the tool should have an entry and exit line and
radius. The radius will be added tangent to the start feature of the toolpath and the line will be
tangent to the radius.

12. Close the Contour Process dialog (Ctrl+W).

The processes that will rough and finish the shape have now been completed. The order in
which operationswill be created is based on the order of processes in the Process list. Anytime
a roughing process is created, all other processes in the same Process list will work in reference
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to the roughing process. Drilling processeswill drill entry holes for the pocket. Contouring
processeswill automatically finish the pocket. Combining processes in thismanner make “multi-
process operations”. Multi-process operations are very powerful and useful in that the
processes have an associativity to each other, making your job easier.

Basic Operations 1-3

With the Process list complete, we need to select the cut shape. Pocketing roughing operations can
only be performed on closed shapes.

1. Click anywhere on the large, outer shape.

When creating pocketing roughing operations, it is only necessary to select one feature of the
contour to be pocketed. Because pocketing roughing processes can only be applied to closed
shapes, you need only indicate which shape you wish to pocket and the systemwill do the rest.

2. While holding down the Ctrl key, click any point or feature of the boss.

Holding down the Ctrl key allows you to select more than one piece of geometry at a time.
Once the pocket geometry is selected, the floating Do It button next to the Process tiles
becomes active. Clicking on the Do It button applies the entire Process list to all selected
geometry, creating asmany operations as are required.

3. Click the Do It button (or press Ctrl+.).

Five operations are created and placed in the Operation list.

The first operation is a drilling operation that drills entry holes. The system determines the
location of the entry holes based on the pocketing geometry selected. The next two operations
rough out the pocket. Two drilling and roughingmoves are created with retracts because the
Rough Endmill cannot fit through the small opening in the corner. So an entry hole is created for
the Endmill to use.Wewill correct this by changing the diameter of Tool #2 so that it will fit
through the channel. The last operations contour the pocket wall and the island wall.
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4. Open Tool dialog #2 and edit the diameter as shown.

5. Close tool #2 dialog (Ctrl+W).

6. Reselect the geometry. Note that the Redo button is now selectable. If any changes are
made to the information contained in the Process list, clicking on the Redo button will create new
operations according to the new Process dialog information. If the old operations are still
highlighted when the Redo button is clicked on, those operationswill be deleted and replaced
with the new operations created from the revised Process list.

7. Click the Redo button (or press Ctrl+,).

The toolpath will be recreated according to the new tool specifications.We now have four
operations. The toolpath is drawn on the screen. Orange lines—both dashed and solid—
represent the operation toolpath. Dashed orange lines signify rapidmoves, while solid orange
lines signify feedmoves. The gray dashed lines represent inter-operationalmoves and
approach/retract moves.
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Rendering the Multi-Process Operations

Let’s take a look at what we have created.We are going to render the part.

1. Click the View button (F5).

2. Select the Isometric View (Ctrl+I).

You can choose whether you want to run one of the Simulations, or LegacyCPR which can be
faster.

3. If you want LegacyCPR for instance, click on the arrow under the currently selected
Render button in the Command Palette and scroll to Legacy CPR. Click to select and run.

WhenCut Part Rendering is in operation, the part will no longer appear as a wire diagram but
instead will be displayed as a 3D solid model. The Cut Part Rendering palette appears on the
screen, this palette gives you control over the Rendering process.

4. Click the Run button.

Use the Rewind button to replay and if you need to, adjust the speed of replay using the slider
control. A part can be rendered any time after operations have been created. The stockwill
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always be drawn in shades of blue. Highlighted operationswill render in shades of yellow, while
all other operationswill render in shades of gray. Red will be displayed when non-cutting tool
surfaces or rapidmoves hit thematerial. For more information, refer to the CommonReference
guide, "Cut Part Rendering" chapter.

5. Click the close button to exit renderingmode.

Basic Operations 5 and 6

Weare now going tomove on to the next operations but before we do we need to do a little
cleaning.

1. Deselect the highlighted operations by clicking on an emptyOperation location or by clicking on
an insertion point betweenOperation locations.
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When operations have been satisfactorily completed, it is very
important that they be deselected before proceeding. By deselecting
the completed operations, they become fixed in the Operations list
and will not be affected by changesmade to the Process list.
Operations can be edited, but to do so theymust be reselected.

2. Hover your mouse over the Axis block in the lower left corner of
the workspace.

A temporary view palette appears. Move themouse to Top view (just to the
right of the “home” button) and click it.

If you prefer, this can also be accomplished by selecting Top View from theMainMenu View
dropdownmenu. All items available in the View Control Palette can be accessed from this View
dropdownmenu.

3. Click somewhere off the shape to deselect the part geometry.

Now, wewill create contouring operations to finish the outside wall of the part. After operations
have been created from the Process list, the entire list of Process tiles can be thrown away, and
you can start creating a new Process list from scratch. However, sometimes it ismore efficient
to simplymodify existing Process tiles rather than to create new ones.Wewill edit existing
processes.

4. Click and Drag the Holes Process tile in position #1 to the Trashcan. (Mouse-drag the tile.
When the hand symbol is over the trashcan the trashcan lid will open - let go themouse button
and the tile will disappear.)

5. Right-click the existing Roughing Process tile and choose Change Process from the
menu. Select a Contour Process.



BasicMill Tutorial

26

This will automatically change the existing roughing process to a contouring process. Tool #2
will be used again for the contouring process, so no tool changes need to bemade.

6. Set the process parameters as
shown.

We are leaving behind 0.175" of
stock to create the outer wall. We
will cut thematerial in two steps of
0.25".

7. Double-click the Contour Process in position #3 (Process 2 will close automatically) and change
the Stock± amount in this pass to 0.15.

This will cut off 0.025" of material, leaving a 0.15" thick wall.

8. Close the Contour Process dialog (Ctrl+W) .

Contouring processes that are not associated with roughing processes useMachiningMarkers
to designate the cut shape. Thesemarkers specify the Start and End feature, the Start and End
point of the cut shape, the cut direction and which side of the geometry to cut. The arrows allow
you to choose the cut direction. The three circles allow you to choose where the tool will cut in
relation to the cut shape.When geometry is selected for contouring processes, theMachining
Markers appear on the selected geometry. For more information onMachiningMarkers, refer to
theMill user guide, "Machining" chapter.
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9. Click the outside shape in the position shown.

TheMachiningMarkers will appear at the location where the
shape was selected, as shown below.

10. Now click the outside circle.

11. Click the arrow pointing right to create the toolpath for a
clockwise contour.
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12. Drag the Start Point Marker (white circle)
and End Point Marker (black circle) to the
positions shown.

These positions lie on the large arc that we trimmed to create the arc that theMachining
Markers are positioned on.When the Start Point Marker is dragged off the part, it automatically
snaps to the nearest extension of the selected Start feature. The End Point Marker works in the
samemanner.

In this case, the start feature is the same as the end feature. Also, when we selected geometry
for the contour, we clicked on the feature wewanted to start and stop the cut on. Because the
MachiningMarkers appear at that point, it is not necessary tomove the Start and End Feature
Markers.

13. Click the Do It button (Ctrl+.).

The toolpath is drawn in orange. The
dashed gray lines represent the
approach and retract moves to and
from the toolpath. In this case, they
are all rapidmoves.

14. Select the Isometric View (Ctrl+I).
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The rendering process does not restart whenever the view is changed, therefore you can change
the view at any time during rendering to get a better view. Use the slider to slow or increase the
speed or rendering at any time.

15. Click the Rendering button on the Command palette (F6).

The cut part rendered image should look like this picture.

16. Deselect highlighted operations.

17. Select (Ctrl-click) then drag the Contour Processes in position #2 and #3 to the Trashcan. The
Rendering will restart and reflect the change.

There are two areas on the part stock that need to be roughed before the contouring operations
that finish the outside wall are done. Geometry for this roughing operation has not yet been
created. You can add geometry to a part at any time.Wewill put the roughing geometry in a
different workgroup.Workgroups are used as layers to separate different sets of geometry to
limit confusion when creating complex parts.

18. Close the Simulation palette.

19. Select the Top View.

20. Close the View Control Palette by clicking the View button again (F5).

Now look at the Operations list. Just above the list are a series of options.
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21. Click the button as shown. This will enable Tile stacking, where consecutive operations, which
machine the same geometry and belong to the same flow, can be stacked together. This can
dramatically reduce the space operationswould otherwise occupy on the operations tile list.
Double-click a tile stack to open a flyout showing the contents.

22. Click the button again to return to normal view.

Basic Operation 7: Manual Toolpath

The contour operations left somematerial behind outside the pocket. We are going to remove that
material.

1. Open theGeometry palette (F2).

2. Click the small down arrow to the right of theWorkgroup Selection button.

This displays all the workgroups associated with the part and enables
you to easily switch back and forth between them. The current
Workgroup is always highlighted in blue.
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3. Move themouse toNew Workgroup and click it.

Another workgroup is created, and theWorkgroup dialog opens. This second workgroup is now
the current workgroup, highlighted in blue and indicated by an open eye. Also, you will notice
that the screen now displays an empty stock outline.

It is advisable to label the workgroupswith appropriate names so that it is easy to tell what each
workgroup contains.

4. Enter “Roughing Operations” in the Comment box as
shown. Double-click in the comment box to enter the
text.

In order to create the geometry for the necessary roughing operations, we will need to view the
part geometry that we have already created. You will notice that the geometry on the screen has
disappeared. This is because the active workgroup (Workgroup 2) has no geometry.

5. Double-click inside the eye ofWorkgroup 1 as shown below. An open eye appears . The
geometry from that workgroup now appears in gray as a background element. Any geometry
created in the current RoughingOperationsWorkgroup will be drawn in the standard blue and
yellow.

6. Close theWorkgroup dialog.
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The part geometry previously created is drawn on the screen in gray and cannot be selected or
changed without switching workgroups.

Now, wewill create the roughing geometry. Since the roughing operations do not require geometry
that must adhere to any blueprint specifications, we will simply create points and lines using the
mouse.While thismethod does not provide for exact precision, it is the fastest way to create
continuous, connected lines.

7. Click the Line button.

8. Select theMouse Line button.

A geometry dialog will appear when theMouse Line button is clicked. The X and Y values are not
entered, but are determined by the location of themouse. As youmove themouse, those values
automatically change. The Z value specifies the depth at which the line(s) will be created. The
Grid value specifies the grid spacing that the points created by clicking on themouse will snap to.

9. Enter Z value and Grid value shown.

When using theMouse Linemethod to create lines, you can select a tool and an outline of that
tool’s diameter will be shaded around all lines as they are created.
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10. Select tool #2.

Double-clicking on a Tool tile will bring up the Tool Creation dialog. A single click will select the
tool and highlight it.

11. Click positions 1, 2, and 3 as shown.

Points are created wherever you click themouse, and a line will be drawn between the points
created. All geometry created using thismethod is fully connected; the endpoints of the contour
are terminators and the points between lines are connectors. You want to make sure the path of
the tool covers the area of stockwe need to rough.

Because we are only going tomake one contour to remove all of the excessmaterial, we will
need to rapid the tool over the part. In order to do that we will change the Z value in the
geometry dialog.

12. Change the Z value and click the Rapid
checkbox as shown.

This geometry dialog is unique in that it allows you to create rapid geometry. It is especially
useful to efficientlymove around the part and avoid tool interference.

13. Click the last point created again.

This will create a rapid line above the stock and ready to rapid over the part. This next step
demonstrates how to create a rapidmove over a part to a desired position.
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14. Click in the location of point #5, as
shown.

The line created is dashed and blue, indicating that it is a rapid and connected line, and the
shaded tool diameter is not drawn. If the part was rotated, it would clearly show the rapid up to
point #4.

15. Change the Z value and turn off the
Rapid option as shown.

16. Click again on point #5 (to feed back
down into the part) and create a zig-zag
pattern similar to the one shown to clean
up the corner.

The actual pattern is not important, just
be sure to cover the area with the tool.

17. Click the Return to Geometry Creation palette button.

18. Close theGeometry Creation palette.

19. MainMenu View > Redraw (Ctrl+R).

To confirm that the lines are at the correct Z depths and that the rapid line over the part was
done correctly, we will switch to a view that allows us to see the depth dimension of our drawing.
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20. Switch to the Isometric view
(Ctrl+I).

Themost common problem encountered at this point involves the rapid line. If you did not
reselect any points after changing the information in the geometry dialog, the rapid line will
either not be above the part or will be slanting up. If this is the case, delete themouse lines and
start over, making sure that you click all the necessary points.

21. Return to the Top view (Ctrl+E).

22. Create this Contour Processwith
the 5/8” Rough Endmill (Tool #2).
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23. Click the part geometry as shown.

MachiningMarkers will appear on the geometry.

24. Set theMachiningMarkers as
shown, ensuring that you select the
center circle.

The Start and End Point Markers and the Start and End FeatureMarkers will move to the
correct positions.

In this particular example theMachiningMarkers automatically snapped to the correct position.
If this were a closed shape, however, that would not be the case.

25. Create the toolpath for this Process (Ctrl+.).

To quickly position the End Feature and End Point Markers, hold down
Shift+Ctrl and click the desired end feature. Then position the End Point
Marker.

26. Switch to the Isometric view (Ctrl+I).
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27. Render the Operations.

The excessmaterial should now be
removed.

28. Exit Rendering.

29. Deselect any highlighted operations.

30. Empty the Process list.

Basic Operations 8-10: Tapped Holes

Finally, we will create operations to drill and tap four holes. To do this, we will need to switch back to
the first workgroup so that we can select the points to drill.

1. SelectWorkgroup 1 in theWorkgroup Selection pop-upmenu.

2. Return to the Top View (Ctrl+E).
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3. Create a Holes Process as shown
using the 1/4” Spot drill (Tool #4).

This processwill drill a chamfer for
the tapped holes. The spot drill
goes to its full diameter at Z = -0.5.
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4. For the second process in themulti-
process group, create a Holes
Process as shown using the .201”
Drill (Tool #5).

This process drills the tap hole. We
are sure to send the full diameter of
the tool all the way through the part to
Z = -0.76".
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5. For the third process in themulti-
process group, create a Holes
Process as shown using the Tapping
Tool (Tool #6).

The process taps the hole. Be sure to
select Tap for the Entry/Exit Cycle.

Wewill now select the points to be drilled and tapped.

6. Ctrl+click the four points shown
below.
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7. Create the toolpath.

Three drilling operationswill be created and placed in the Operations list. The holes will be
drilled in the order theywere selected, so the toolpath on your screenmay vary slightly from the
one shown here.

Multiple drilling operations created from one Process list generate a subprogram of the selected
pattern of points to be drilled in the posted output. Each of the operations that uses that pattern
of points calls that subprogram in the posted code.

8. Switch to the Isometric View.

9. Render the Operations.

Basic Operation 11: Tapered Boss

Now wewill create a tapered wall on the boss. The boss geometrymust be drawn at the correct Z
depth in order for the taper to be created correctly. The system calculates the taper from the Z level
of the geometry, not the Surface Z value entered in the Entry/Exit Clearance Diagram.

1. Double-click the boss geometry so that it becomes
selected.

2. ChooseModify > Translate.
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3. Enter the data shown.

4. Click the Do It button (Ctrl+.) and close the Translate dialog.

This will move the selected geometry down in Z to -0.5 which is the bottom of the boss.

5. Switch to the Front view (Ctrl+F).

This allows you to see the geometry
at a different depth level.

6. Switch to the Top View (Ctrl+E).

7. Create this Contour Processwith
the 1/2” Finish Endmill (Tool #3).

8. Click theWall Control button.
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This brings up theWall Choices dialog which provides options for creating tapered
and swept walls.

9. Select the Taper w/Fillets option and enter the
information shown below in theWall Choices
dialog.

10. Close theWall Choices dialog.

11. Select the boss geometry.

Themachiningmarkers will come up on the selected shape.
Make sure the outside circle and right arrow are selected.

The Start and EndMarkers do not need to bemoved.

12. Select Operation tile #5.

This is the operation created from the first Process list that finished the bosswith a straight wall.
By selecting just this operation we can replace it with the new tapering operation.

The Redo button becomes active indicating that an operation can be reprocessed.



BasicMill Tutorial

44

13. Click the Redo button (Ctrl+,).

A new toolpath will be generated that creates a tapered wall on the boss.

Organizing the Operations

All the operations tomachine the part have been created. All that remains is to organize the
operations in the Operations list to provide for themost efficient machining of the part. This will be
accomplished using Sort Operations.

1. Right-click anOperation Tile and choose Sort Operations from themenu.

Sort Operations reorganizes theOperations list according to tool number and creation order.
Operations created from the same Process list will never bemoved in front of each other,
regardless of tool number. For example, the first Process list created four operations. The
drilling operation created first in the Process list will never bemoved below the roughing or
contouring operations created from that same Process list, even if the tool number for the drill
was higher than the numbers of the other tools used in that Process list.

The contouring operations using the finish endmill, Tool #3, will bemoved down in the
Operations list after the roughing operations that use Tool #2. Thisminimizes tool changes and
provides for a shorter cut time.

2. Render the Operations.
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Themachining and rendering of the part is complete. We have a good part and there are no
errors.

Final Steps
Post Processing

Now that all of the operations tomachine the part have been satisfactorily created and verified, we
need to post process the file. Post processing will create a text file that the CNC machine will use to
cut the part.

1. Click the Post Processor button in the Command palette.

The Post Processor dialog shown below opens up. This dialog allows you to select a post
processor, specify a program name and the format of the output.

2. Click the Post Processor Selection button.
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Now select a post processor. Change drives,
directories, or folders in order to locate the post
processors on your system. Typically, post
processors are found in a directory/folder called
Posts. Once the Post folder is chosen in this dialog,
it will remain as the default folder when selecting
post processors.

3. Locate the post processors on your system and
select one that is appropriate, i.e. a 3 (or more) axis
Mill post. If you do not have one, there is one
located in the Sample parts folder for use only with
this tutorial for learning purposes.

4. Click theOpen button.

The name of the selected post processor will appear in the dialog next to the button.

5. Click the ProgramName button.

This reveals the dialog shown. Now name the posted
file and designate where it will be saved.

The ProgramName defaults to the name of the part file. You can change the name or leave it as
it is. Part files have a *.VNC extension while posted output files have an *.NCF extension.

6. Click the Save button.



BasicMill Tutorial

47

Once you have selected a post processor and named and saved the program, the Process
button at the bottom of the dialog becomes active.

When you click the Process button, the system generates a text file that can then be
communicated to the CNC machine to cut the part.

7. Click the TextWindow button.

This will extend the dialog, allowing you to view the posted code as it is processing.

The actual dialog that appearsmight be different. If you have chosen to use the Internal Post

Editor in the Preferences > G-Code Editor Settings dialog, then that will also open in another
window. This customizable, color-enhanced editor allows you to directly edit the program using
cut/copy/paste etc., with multiple subs and flows clearly distinguished. You can also find a link to

this internal editor under the Plugins >Main toolsmenu , which will enable you to edit
existing .ncf files without having to open the .vnc file.

8. Click the Process button.

You can click the Pause button on your keyboard tomomentarily stop the processing so that you
can read the program. Once the program has finished processing, the Print button becomes
active and the posted code can be printed. Now that the program has been generated, it can be
used to cut the part on the CNC machine. Any necessary changes can bemade using the
internal post editor

9. Save the part file.
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This tutorial is complete.
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Hole Manager and Hole Feature
Hole feature is a tab located in the Drilling dialog. It can be a powerful tool for machiningmultiple
hole segments when used with HoleManager.

In this exercise wewill machine a part using theMatch Segment by Properties/Index in the Hole
Feature Tab.

1. Open part file “HoleMatch.vnc” located in the Sample Parts > Production> Tutorial Parts -
Required folder.

Looking at this part, you can see there are three holes, with varying length and number of
segments. Four tools are provided in the tool list.

2. Select the part by clicking anywhere on it (it will turn yellow).

3. Open HoleManager (Features > Hole Manager) and click the Run AFR button.

Wewill now create operations tomachine these holes, using the data from the HoleManager.
You will note that the leftmost hole (with four segments) is the first hole in the list. This is our
Reference hole the details of which are used in the Hole Feature Tab. Right-click the word
Compound on the first hole (H1). Select Edit from themenu. Examine the hole profile by clicking
within the Hole Diagram but do not change any values.

4. Close the dialog.
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Click on the segments in the Hole Diagram
window to examine the segment data.

5. Click (Ctrl+A) in the Hole List to select all the holes.

6. Create a Holes process by double-clicking a process tile and selecting the 16mm
Endmill (Tool #1). Wewill be using this tool to drill the bottom segment.
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7. Click on the Hole Feature tab.

Set the R level to FromHole Featurewhich
means the R level data will be taken from the
HoleManager. (Top of hole plus Top Clear
value).

At Op End should be set to Same as R level.
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8. Choose the Segment Start option in Start Depth dropdown. This
opens a further dropdown, listing all segments that are part of
the Reference Hole (H1). Select Segment #4, the bottom
segment. Choose Segment End and Segment #4 for Feature
Depth Z.

9. In the Segment section (bottom right of the dialog), choose theMatch Segment by Properties
Radio button and checkDiameter. Thismeans that for all other holes, it will drill the first segment
that is the same diameter as the 4th segment of the reference hole. (16mm)

10. ClickDo it .

Holes 1 and 2 aremachined. You will notice
that the toolpath stops at the bottom of the
hole. In this case, as this is a through hole,
we want to plunge deeper to clear the
bottom. Hole 3 is not machined because it
has no 16mmdiameter segment.

Double-click the Holes Process and add an
adjustment value of -5 to the Process dialog as
shown.

11. Click Redo .
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This time the tool plunges all the way through
the hole.

12. Deselect the Operation tile and drop Tool #2 onto the existing Process #1. The Drill Tab isOK,
but in the Hole Feature Tab enter the following:

Wewill machine Segment 3 and any other
segments that match the diameter of segment
3 regardless of their length.
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13. Create another Holes Process at position #2
using Tool #3, the 32mmREM. Enter the
following into the Hole Feature Tab.

14. Create a Holes Process #3 using Tool#4, the
40mmREM. Enter the following into the Hole
Feature Tab.
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15. Render the Operations.

The top segment of the last hole has not been drilled - if you lookmore closely at the part you
can see that it is wider than the others.

16. Double-clickOperation #4 and drop tool #2 onto it. Wewill Helix bore the first segments instead.
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You will notice that the Bore tab has now
also become active.

17. This time wewill not match the hole by
diameter, as wewish to helix into the top of
all holes, regardless of diameter. Choose
theMatch Segment by IndexRadio button.
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18. In the Bore tab enter the following:

19. Render the operations.

20. Save the part.
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Feature Manager
In this exercise wewill add features to a part using the FeatureManager and then use the features
tomachine the part.

1. Open part file “Mill Feature.vnc” located in the Sample Parts > Production> Tutorial Parts -
Required folder.

If you look at this part you will see that there are pockets on three of the surfaces.

2. ClickFeatures > Feature Manager on theMainMenu, to open the FeatureManager
Dialog.

Keep this dialog open throughout the tutorial.

3. Select the pocket shown below. (Click the bottom of the pocket, then right-click it
and choose Select> SelectWall Faces.)

4. Ensure that Face Selection (on the floating Taskbar) is enabled .

5. In the FeatureManager dialog, click the Create Feature fromSelected button and enter
details as follows.

If you cannot see the color displayed on your screen, ensure that the Feature Color display
mode is on. This is located in the Floating taskbar.
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6. Repeat the last two steps, until all pockets on the top surface have been added to the Feature
Manager.
Your FeatureManager dialog and screen will look as follows:

(The choice of color is not important.)

7. Now select the side pocket, making sure to look all around the part to ensure all surfaces are
selected. Save the feature as Side Pocket 1.

Wewill now create an attribute for the CS.

8. In the FeatureManager click the Create new

Attribute button . Enter the following in the dialog.

9. We need to edit the Features to add this
new attribute. Click in the newly created
column and add the following CS values:

The part is now ready to bemachined. First we will load some tools from the Tool list we set up in
theMill tutorial.
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1. Right-click on any Tool Tile to display the Tool list menu as shown.

2. Select the option View/Edit Tool List and navigate to the sample file tools.tlst.

3. ClickOpen. The tool list opens.

4. Ctrl-click the tools as shown to select
them, then right-click and choose the option
Import to part.

The tools will be inserted into the tool tiles. You can also drag the tools individually onto the tool tiles
- Rough Endmill to Tile #1, Finish Endmill to Tile #2.
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5. Close the Tool List dialog.

6. With Tool #1 create the following Pocketing
Process.

You will notice theMill Feature Tab is bold, meaning that settingswill be applied.

7. Enter the settings shown below into the tab.
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Approach and Retract Z are set to
Incremental. The distance between the
Clearance Plane and the Top Surface
will be updated for each hole.

Top Surface and Depth Z are set to
Automatic. The value will come directly
from the geometry of the user feature.

Notice theMach CS Dropdown is no
longer available. This is because the
Machining CS details are taken from
the attribute set in the Feature
Manager.

8. With Tool 2, create the following Finish
Pocketing Process. TheMill Feature Tab
will already be populated with the values
set in the previous process. Leave these as
set.
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9. In the FeatureManager dialog,
select all Features (Cursor on
first Feature, then Shift-click
bottom Feature, or Ctrl-click
each of the rows).

10. Click Do it on theMachining dialog.

Fourteen operations are created., machining each of the pockets selected in the Feature
Manager.

11. Render the Operations.

Try adding the surfaces located on the bottom of the part to the FeatureManager and thenmachine
them also.

Drilling Multiple Orientations using Hole Feature
This is a short exercise to demonstrate how the Hole feature tab, used in combination with Hole
Manager can create operations for holes in multiple Orientations.

Please note that Mach. CS “FromHole Feature” in the Hole Feature Tabmeans that holes will be
grouped together according to their orientation. One operation will be created for each orientation.
For each of these operations, if there is already a CS that is aligned with hole depth axis, that then
will be the CS assigned to that operation. If there is no CS that matches the hole depth axis, then a
new CS will be created and assigned to the operation.

1. Open part "Hole Feature CS.vnc". This already has two tools set up.

First we need to select the holes tomachine.

2. Open Hole Manager, select the part and Run AFR.

24 Holes are found.

3. Select all the holes (Click into the HoleManager and (Ctrl-A)). Then click theMake Group
button.

A single Group is created with 24 holes.
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4. Click onGroup 1 to select it, then click
Reorder.

5. In order to see the toolpath correctly we will change the Display Options. Click theOptions button
at the bottom right of the Reorder Group dialog. Enter the following:

6. Click onGroup 1 and click Reorder. This opens the Reorder Group dialog.

7. Now click the Draw Order button. This will highlight and number themachining order. You will
see that the toolpath is all over the place. If this is not working, ensure the Show order checkbox
is checked.
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8. Now Click Rotary Sort, enter details as shown below then click Do it .

The toolpath is sorted.
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9. ClickOK and return to Hole Manager. Group 1 should remain selected. Any holes selected within
HoleManager will be the ones used in the operations. Make sure the HoleManager dialog is
left open, this ensures that the Hole Feature Tab can use the values contained within Hole
Manager.

Now wewill create two processes, one to Spot drill each hole and the other to Drill them.

10. Create a Holes Process using the 2.00 Spot tool (Tool #1).
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11. Create another Holes Process using the 3.5 Drill (Tool #2).

12. ClickDo it on theMachining dialog.

A total of six operations are created, two for each hole orientation. You will note that hole depth,
orientation and top clearance values are provided by the HoleManager and require no user
input.

13. Save the part.

Part Duplication
Wewill use the completedMill tutorial part for this exercise.

1. Open your savedMill Tutorial.vnc file.
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2. In order to view part duplication, youmust to open theOp SimRendering palette.

Leave the Rendering palette on the screen during the entire tutorial. This will enable you to
immediately see the duplication pattern as youmake changes and then play/rewind the
operations. In themean time, just move the palette to the side of the screen.

3. Open the Document Control Dialog.

4. Change your workspace view to Isometric and adjust your screen so that the DCD, the
part and theOp Sim palette are all visible.

5. From the bottom section of the Document Control Dialog, click to open theMulti-Part tab. Now
choose Part Duplication from the dropdownmenu as shown below.
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TheMulti-part dialog now opens. First we will turn our attention to the Duplication Type. (Area
highlighted below). This is where we specify the grid pattern.

Equally Spaced
1. Wewill start by setting up an Equally spaced pattern.

Equally spaced will duplicate in one direction specified by theOrigin Offset.

2. Change the number of parts to 3 and the origin offset to 12 as shown below.

Immediately you will notice that 3 parts are displayed on the screen, extending in one line.

3. Render the operations.

The first operation is performed on each part in turn, returning to the first part to start the next
operation.
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4. Change the Y offset to 5. Immediately the
parts are alsomoved in the Y direction.

There are three other useful options on theMulti-Part tab which are common to all duplication
methods.

• The Transversal Options buttons allow you to choose the tool retract betweenmoves. It can
either be to theOff Part Location specified in your MDD, or to the Tool Clearance amount you
specified in theWorkspace tab of the DCD.

• The checkbox Complete Each Part Firstmeans that all operationswill be completed on a part
beforemoving onto the next.

• If Back and Forth is checked, the next operation will not return to the first part, it will instead
perform the next operation on the last part and work back to the beginning.

Feel free to experiment with different Number of Parts, Origin Offset amounts and other options
beforemoving onto the next duplication type.

Grid Duplication
Wewill now tryGrid duplication.

Grid will duplicate in a grid pattern. You need to specify the number of parts in each direction and the
fixed grid offset.

1. Change the Duplication Type to Grid.

2. Change the number of parts in X to 4 and number of parts in Y to 4. This will create a parts grid
of 4x4, or 16 parts.

You will notice that the display does not seem to change. This is because all the parts are on top of
each other. You need to set the offset distance to separate them.

3. Enter 12 in the X and Y direction fields as shown below. You will now see all 16 parts in an even
grid pattern.

You now have twomore dropdown options,Order and Direction.
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TheOrder determines in which axis the toolsmove. You can choose tomove in X or Y or whichever
is shortest. The “shortest” means that if the grid is X=4, Y=3, the direction of the cut will be in Y. The
first cut is always at 0,0,

4. For this tutorial we will choose X First.

Next wemust choose Direction. If we chooseOne-Way the tool will start at 0,0, move along the X axis
to the end of the row, then return to the beginning of the next row. Once the first operation is
completed on all parts, the next operation then continues in reverse order from the last position.

5. Choose Zigzag pattern as shown below, this will serve tominimize tool travel.

6. Render the operations.

Again feel free to experiment with different numbers of Parts, Origin Offset amounts and other
options beforemoving onto the next duplication type.

Define Positions
Define Positions allows you to specify your own specific grid positions for each part and enter them in
machining order.

Once again the first part is automatically set at 0,0, but you can specify this to be either from the
Machine or Part Origin. Each line in the dialog is another part location, with the line number defining
themachining order. As you type the location into the fields, the part is displayed on the workspace.
Click Add to start the next entry. X will remove an entry and the remaining parts will be renumbered.
Continue adding grid locations as shown below.

Render the operations and save the part.
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PART PRINT
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